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Setelah Anda mempelajari penggunaan umum photoshop, Untuk lebih 
detil penggunaan Tool photoshop sbb:

RETOUCHING TOOL

1. Healing Brush Tool
1. Healing Brush Tool

Healing Brush Tool digunakan untuk memperbaiki gambar pada bagian tertentu. 
Aktifkan tool ini, kemudian tekan Alt + Klik pada objek pada bagian yang tidak 
berkeriput, kemudian klik pada bagian yang keriputnya ingin dihilangkan.

2. Spot Healing Brush Tool
Spot Healing Brush Tool digunakan untuk memperbaiki kerusakan gambar. Di sini 
Anda tidak perlu menentukan area yang akan digunakan sebagai patokan, karena akan 
secara otomatis terpilih dari area di sekitarnya. Misalnya digunakan untuk 
menghilangkan keretakan pada patung seperti pada gambar 2.10.

3. Patch Tool
Patch Tool digunakan untuk memperbaiki gambar. Tool ini dibuat dengan cara 
membuat selection dengan mouse atau dengan menahan tombol ALT untuk 
menghasilkan bentuk poligonal. Selanjutnya drag ke daerah yang akan dijadikan 
patokan perbaikan.

4. Red Eye Tool
Red Eye Tool digunakan untuk memperbaiki warna merah pada mata.

http://ilmuphotoshop.com/2010/03/25/menghilangkan-kerutan-di-wajah-dengan-photoshop/
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2. Clone Stamp Tool
Clone Stamp Tool digunakan untuk membuat duplikat area pada gambar, atau yang 
disebut cloning. Tekan ALT pada objek yang akan dikloning, kemudian gunakan mouse 
pada area tempat objek baru mau diletakkan. Contoh Menghilangkan tiang telepon pada 
gambar asli

  

Gambar Asli  Kloning Gambar

  

3. 2.3.8. Background Eraser Tool
Tool ini digunakan untuk menghapus background yang memiliki kemiripan warna. Misalnya 
digunakan untuk menghapus background langit pada gambar kupu-kupu.
4. 2.3.9. Magic Eraser Tool
Seperti Background Eraser Tool, tool ini akan menghapus area dengan warna sama, namun 
efeknya adalah ke seluruh gambar, bukan hanya area yang diklik.
2.3.10. Color Replacement Tool
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Color Replacement Tool akan mengubah warna gambar tanpa mengubah bentuk dari gambar 
tersebut. Tool ini akan secara otomatis hanya mengubah area dengan warna sama menjadi 
warna lain yang dikehendaki.
5. 2.3.11. Blur, Sharpen, dan Smugde Tool
Blur Tool digunakan untuk mengaburkan area. Misalnya digunakan untuk menghilangkan 
bintik-bintik pada wajah. Sharpen Tool merupakan kebalikan dari Blur Tool. Dengan Sharpen 
Tool, gambar akan menjadi lebih tajam. Smugde Tool digunakan untuk mengubah bentuk 
gambar dengan cara drag mouse.
6. 2.3.12. Dogde, Burn, dan Sponge Tool
Dogde Tool digunakan untuk membuat area menjadi lebih terang. Burn Tool digunakan untuk 
mempergelap area. Spong Tool digunakan untuk mencerahkan (saturate) atau mengurangi 
warna (desaturate).

Kloning Tool Stamp?

Kloning Stamp Tool ini tidak persis apa namanya. Menggunakan alat ini, Anda dapat 
menyalin sebagian gambar dan permohonan kembali berulang kali untuk menutup suatu 
bagian gambar yang tidak diinginkan. Contoh di bawah ini menunjukkan sebuah tiang 
telepon di gambar asli; Clone Stamp Tool memungkinkan kita untuk menutupi tiang telepon 
dengan rumput sekitarnya, gulma dan langit dan membuat gambar baru yang tidak 
mengandung tiang telepon.

  

Gambar Asli  Kloning Gambar

  
Untuk menggunakan cap kloning:

1) Pilih Clone Stamp Tool dari toolbox.

2) Pada bar Pilihan di bagian atas layar, pilih ukuran kuas dan jenis sikat yang ingin anda 
gunakan:
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(Klik panah di sudut kanan atas palet kuas untuk melihat menu untuk pilihan kuas 
diperpanjang.)

3) Pindahkan kursor di atas gambar ke area yang ingin Anda mereproduksi tempat lain.

4) Tahan tombol Alt dan klik untuk memilih area untuk mengkloning dari.

5) Ketika Anda melepaskan mouse, sikat akan muncul pada gambar dalam bentuk sikat 
yang dipilih. Crosshairs akan muncul atas wilayah tersebut untuk direproduksi dan bergerak 
dengan sikat.

6) Klik berulang kali atau tarik mouse untuk mereproduksi pola.

Tip: Clone Stamp Tool lebih mudah untuk digunakan ketika Anda zoom in pada area yang 
diinginkan. Juga, bekerja sama dengan bagian-bagian kecil pada waktu untuk membuat 
gambar tampak lebih realistis.

Menghilangkan Jerawat dengan Clone Stamp Tool

Posted by: listcreative on: Juli 17, 2009

 In: Tutorial
 Comment!

Ada enggak nih yang gemar melihara jerawat. Terus tiba-tiba ngajuin lamaran kerja, eh 
ternyata enggak lolos gara-gara ada jerawat di fotonya. Bisa lolos dengan syarat harus 
menghilangkan jerawat di foto. (He…he…).
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Ada juga yang enggak PD yah, ketika mau upload foto ke Friendster, Facebook gara-gara 
wajahnya jerawatan. Gampang kok??, asalkan punya program Photoshop di komputermu, 
tapi kalo enggak punya komputer ya pinjem temen dulu deh?. Bilang baik-baik ma temenmu 
itu kalau kamu mau ngilangin jerawat?, (He..he..).

 Buka program Adobe Photoshop versi 7.0 ke atas aku sarankan. Yang terbaru juga 
lebih baik.(Aku pake versi yang CS4).

 Setelah itu ambil fotomu yang penuh jerawat itu yah??. (Disini aku pake contoh foto 
dua remaja item manis yang aku dapet kebetulan pas iseng-iseng kesasar di 
Friendster, hee…hee…, maaf yah buat dua gadis item manis tersebut??, santai aja 
tak bikin cantik kok??).

 Pilih Clone Stamp Tool dan klik. Jika disitu yang muncul Pattern Stamp Tool, lakukan 
dengan klik tahan sampai muncul Clone Stamp Toolnya dan pilih.

 Setelah itu klik kanan pada layar (ada yang menyebutnya kanvas ada pula yang 
bilang ruang kerja). Nah, nanti akan muncul properti dari Clone Stamp tool tersebut. 
Lalu atur Master diameternya, pilih yang Soft Round yah??, hal ini biar sisi-sisi yang 
mau dikloning nanti terlihat halus, tapi kalau kamu pilih yang Hard Round, yang akan 
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terjadi adalah sisi-sisi yang dikloning akan terlihat tegas, jadi terlihat kayak ada 
potongan deh?. Master diameternya terserah kamu mau pake berapa pixel, yang 
pasti semakin besar pixelnya maka semakin besar pula pensil (disini dalam bentuk 
lingkaran) yang akan dipakai untuk mengkloning. Ingat loh, yang akan 
terkloning(terkopi katakanlah) adalah yang ada didalam lingkaran (Lingkaran yang 
dimaksud adalah pengganti pointer mouse setelah kamu mengaktifkan Clone Stamp 
tool).

 Setelah benar-benar mantap dengan pengaturan properti, lalu perhatikan baik-baik 
gambar diatas. Warna biru adalah area yang tidak ada jerawatnya dan area inilah 
yang akan dikloning untuk menambal area di warna merah yang ada jerawatnya. 
Ingat, kamu harus perhatikan betul warna kulit yang akan dikloning, sebab nanti kulit 
yang aku beri tanda warna biru akan menutup ke kulit yang aku beri tanda warna 
merah, jadi jerawatnya ilang deh, karena sudah ditutup. Kenapa aku pilih disitu yang 
aku kloning??, karena warna kulitnya sama dengan yang kutandai warna merah, hal 
ini agar terjadi kesamaan pada hasilnya nanti. Nah, cara melakukan kloning tuh gini; 
pointer yang berupa lingkaran itu arahkan tepat diatas gambar yang mau dikloning. 
Kalau sudah dianggap tepat, lalu untuk melakukan kloningnya pencet tahan tombol 
Alt pada keyboard, nanti pointer yang tadinya lingkaran akan berubah bentuk, setelah 
itu tinggal di klik aja deh, maka otomatis akan terkloning. Lalu lepas tombol Alt 
kemudian klik ke arah mana yang jerawatan tersebut.

 Hasilnya lihat aja pada gambar diatas ini.
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 Nah, sudah jelas khan?. Kalo sudah, lakukan dengan jerawat-jerawat yang lain. Tapi 
tetep ingat, kamu harus jeli melakukan pengkloningan agar kulit yang dikloning sama 
dengan yang akan ditutup. Kalo dirasa lingkarannya pada pengganti pointer mouse 
kebesaran atau kekecilan, lakukan dengan klik kanan aja biar propertinya muncul, 
nah tinggal ubah aja pixelnya.

 Akhirnya jadi deh, ilang semua jerawatnya. Wah, jadi jatuh cinta aku ama gadis item 
manis itu??. (Hee…hee…..). SELESAI…………….,

 Nah, kalo kamu merasa sampai disitu belum cukup. Maunya agar footo kamu tampak 
lebih soft dan putih, yang menyebabkan jerawat kamu juga tak tampak sama sekali, 
caranya begini : masih difoto yang tadi, Klik fitur Menu – Filter – Distort – Diffuse 
Glow, nanti yang akan muncul adalah properti pada gambar diatas (gambar diatas 
terlihat bila kita pake photoshop Cs2 ke atas).
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 Lalu atur properti tersebut. Ingat, kalo foto kamu pengin halus Graininess harus di nol 
kan (0).Soalnya kalau semakin dibesarkan maka foto kamu akan tampak seperti ada 
Noisenya. Nah, untuk Glow Amount dan Clear amount otak atik aja sesukamu 
sampai kamu menemukan wajah kamu yang dirasa cocok dan pas.

 Hasilnya dapat dilihat seperti yang aku contohkan diatas ini, upz…cantik sekali gadis 
itu.

MANIPULASI FOTO (PHOTOSHOP TUTORIAL)
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Manipulasi foto adalah bagian yang paling diminati oleh 
pengguna Adobe Photoshop di seluruh dunia. Hal ini tentu saja disebabkan oleh banyaknya 
karya-karya manipulasi foto unik yang bisa dihasilkan dari memanipulasi sebuah foto 
standar. Sebagai contoh, pada tutorial kali ini, kita akan menggunakan sebuah tehnik 
sederhana untuk menciptakan kesan 'hantu' pada sebuah foto di Photoshop. sangat 
sederhana! karena cuma menghilangkan kepalanya saja. :D

Lagi-lagi pake fotonya Alyssa! bukan karena saya ngefans sama Alyssa, tapi karena 
kebetulan stock foto yang ada ya cuma ini! :D *jarang ngoleksi foto*

STEP SATOE : Masukkan foto ke Photoshop (Ctrl + O)

STEP DUA : Pada Tool Box di sebelah kiri area kerja, pilih Clone Stamp Tool (S) kemudian 
set Besar Clone Stamp Tool seperti gambar dibawah. Kecilkan besar Hardness. Langkah 
selanjutnya, arahkan kuas dari Clone Stamp Tool pada area dinding di pinggiran kepala 
Alyssa, kemudian sambil menekan tombol Alt pada klik pada area dinding di bagian 
pinggiran kepala Alyssa. Lepas tombol Alt, lalu sapukan kuas ke bagian kepala Alyssa. 
langkah ini digunakan untuk mengganti bagian kepala Alyssa dengan bagian dinding yang 
diambil sampelnya.
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untuk bagian pinggir, kecilkan besar kuas dan besarkan nilai Hardnessnya, sapukan dengan 
hati-hati untuk menghindari kesalahan dalam step ini.

STEP TIGA : Pilih Pen Tool, kemudian seleksi bagian leher seperti gambar dibawah. Jika 
sudah, klik kanan kemudian pilih Make Selection untuk membuat seleksi pada bidang 
tersebut. setelah terseleksi, ambil sampel bagian kerah dan sapukan kedalam bagian yang 
terseleksi dengan menggunakan Clone Stamp Tool.
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STEP EMPAT : Pada Menu Bar, pilih Image>Hue/Saturation. Turunkan besar saturation 
seperti gambar dibawah ini.

STEP LIMA : Pilih Image>Level (Ctrl + L), geser titik hitam di bagian kiri ke arah kanan 
untuk mempergelap bagian yang terseleksi.

STEP ENAM : Jika masih kurang gelap, pilih Image>Brightness and Contrass, turunkan 
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nilai Brightness seperti gambar di bawah.

STEP TUJUH : Pada bagian kerah, masih terdapat noda hitam dari bayangan kepala yang 
menyebabkan kondisi tidak realistis pada gambar. Seleksi bagian tersebut menggunakan 
Pen Tool, kemudian ambil sampel bagian kerah yang paling dekat dan sapukan pada 
bagian terseleksi dengan menggunakan Clone Stamp Tool. Lakukan hal yang sama pada 
sisi kerah yang lainnya. Tekan Ctrl + D untuk Menghapus seleksi.
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STEP DELAPAN : Pilih Burn Tool pada Tool Box untuk memberikan kesan bayangan pada 
bagian dalam kerah (hasil buatan), Kecilkan nilai Hardness untuk memberi kesan gradasi 
pada bayangan.

STEP SEMBILAN : Selesai! buka tab baru di browser dan langsung aplot ke fesbuk! :D
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Bersihkan wajah dengan Healing Brush Tool dan Tool Stamp

Dengan penggunaan Healing Brush Tool dan Tool Stamp Anda dapat menghapus patch, 
titik, jerawat dari wajah. Mengubah foto Anda. Pelajari cara untuk memperbaiki foto.
Di sini kita akan menghapus semua bercak merah di wajah pria ini. Kami merekomendasikan 
menggunakan foto lebih mudah dengan lebih sedikit tambalan.

Langkah 1: Buka foto Anda yang perlu Retouched dengan mengklik File> Open.

Langkah 2

Gunakan Healing Brush Tool . 

Klik atau langsung tekan huruf (J) seperti gbr dibawah ini

Pilih ukuran Brush 24px. Kemudian untuk menggunakan Healing Brush Tool:
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tekan alt + klik untuk memilih area yang ingin Anda clone (1) dan

kemudian pergi ke daerah di mana Anda ingin menyalin (2) dan klik atau seret.
Sebuah tanda plus akan menunjukkan daerah sebelumnya. Melihat demonstrasi di bawah 
ini. 

Gerakkan mouse ke wilayah yang ingin Anda clone (1). Di sini kita ingin menggunakan kulit 
hidung pada laki-laki untuk mengganti tambalan merah di wajahnya (2). 

Sekarang tekan alt + klik pada area (1). Tanda di atas akan muncul. 

Kami ingin mengkloning kulit di mana patch merah muncul (2).

Jadi, klik dan tarik lingkaran yang muncul ke daerah di mana Anda ingin menyalin (2). Tanda 
+ menunjukkan anda area (1) yang sedang disalin. Tanda + akan datang bersama dengan 
lingkaran.

Ulangi metode yang sama sebanyak yang diperlukan untuk membuat wajah terlihat jelas.

Langkah 3

Gunakan Clone Stamp Tool.
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Klik untuk memilih. Sebuah jendela selaras atas akan muncul..

Pilih ukuran Brush sesuai dengan wilayah yang ingin Anda retouch. Di sini kita telah memilih 
24 piksel.

Sekarang untuk menggunakan alat Stamp tekan alt + klik untuk memilih area yang ingin 
Anda clone (1) dan kemudian pergi ke daerah di mana Anda ingin menyalin (2) dan klik atau 
seret. Sebuah tanda plus akan menunjukkan daerah sebelumnya.

Baik Stamp Healing Brush tool dan alat akan memberikan Anda hasil yang sama seperti 
yang terlihat di atas.

Ulangi metode yang sama sebanyak yang diperlukan untuk membuat wajah terlihat jelas.

Adobe Bridge - Spot Healing Brush - Photoshop Creative Suite 2

Spot Healing Brush

Tool ini berfungsi menghilangkan noda atau ketidak sempurnaan didalam suatuh image. 
Tool ini juga lebih umum digunakan untuk membersihkan bagian wajah atau dikenal dengan 
istilah Photoshop dengan "Retouch". 

Penggunaan Spot Healing Brush Tool ini cukup dengan mengklik bagian bernoda saja 
contoh cara menghilangkan noda jerawat, cara menghilangkan kerutan diwajah, atau bercak 
- bercak diwajah dengan mengambil sampel dari daerah sekeliling area spot healing brush.
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Photoshop CS5 New Feature: Spot Healing Brush Tool

Posted: May 11, 2010 by Ruly Ardiansyah in Photoshop
5

Satu lagi fitur baru Photoshop CS5 yang amat menarik. Pasti Anda dapat membedakan foto 
pertama dan kedua di atas bukan? Kabel-kabel yang “mengganggu” pandangan dapat kita 
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hilangkan dengan sangat mudah melalui fitur (tool) baru Adobe Photoshop CS5, Spot 
Healing Brush.

Dimanakah lokasi Spot Healing Brush tool ini? Dia berada satu group dengan Healing 
Brush tool. Di bawah Slice Tool, di atas Brush tool.

1. Buka foto gedung (foto pertama) dalam Photoshop CS5.
2. Pilih Pen tool, karena kita akan membuat sebuah path. Tapi, sebelum Anda membuat 

path tersebut, pilih panel Paths terlebih dahulu, kemudian klik tombol Create New 

Path.
3. Sekarang baru Anda buat path yang melalui semua kabel-kabel. Seperti terlihat pada 

gambar di atas.
4. Setelah path dibentuk, pilih Spot Healing Brush tool. Atur agar Hardness menjadi 

100% dan Type > Content Aware. Kemudian tekan Enter untuk mengisi path tersebut 
dengan Spot Healing Brush.

5. Dalam sekejap kabel-kabel dalam foto tersebut hilang. Mengagumkan? Ya! 

Menghilangkan Kerutan di Wajah dengan Photoshop 

Posted by Sigit eko on Mar 25th, 2010 in Belajar Photoshop, Photoshop Dasar | 59 
comments

Ini kelebihan photoshop bisa menghilangkan kerutan di wajah..hebat kan?  ini berkat tool 
keren yang nama nya Healing brush tool .. dari namanya juga udah keliatan kok fungsi dari 
tool tersebut..  Healing = menyembuhkan artinya tool ini  untuk memperbaiki atau 
menyembuhkan sesuatu yang kurang.

Untuk menghilangkan jerawat bisa ga ? Jelas bisa dong.. nanti saya kasih contoh nya ya..
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sekarang kita praktek langsung aja ya..

buka foto yang mau dibuat hilang kerutan wajah nya.. saya pake foto Om saya.. Om Sean 
Connery ..yang udah lumayan banyak kerutannya..

duplikat layer background dengan menekan ctrl + J .. tujuannya buat sebagai pembanding 
aja.. jadi keliatan perubahannya..
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sekarang klik salah satu tool keren di photoshop Healing brush tool.. ukuran brush 
secukupnya aja..

cara pake nya ..

tekan ALT lalu klik di tempat yang gak ada kerutannya..
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kalo udah tombol ALT nya lepas.. lalu klik di tempat yang berkerut-kerut

Ayo .. hilangkan semua kerutannya.. kalo bisa zoom..

hasilnya :
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sekarang lihat perbandingannya :

simple banget kan ?  kalo tau caranya sih semua jadi simpel.. bener gak ?
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sekarang liat wajah si mpok ini.. tadinya berjerawat akhirnya tanpa obat jerawat.. kulit nya 
jadi Muluuuuss lagi…

Selamat ber eksperimen..

LKS
BUATLAH FOTO BERIKUT MENJADI LEBIH MUDA !!!

Healing Brush Tool (tugas TIK photoshop) 

kelebihan photoshop bisa menghilangkan kerutan di wajah. ini berkat tool keren yang 
bernama Healing brush tool .. dari namanya juga udah keliata fungsi dari tool tersebut.. 

sekarang kita praktek langsung

buka foto yang mau dibuat hilang kerutan wajah nya.. saya pake foto Sean Connery ..yang 
udah lumayan banyak kerutannya..
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duplikat layer background dengan menekan ctrl + J .. tujuannya buat sebagai pembanding 
aja.. jadi keliatan perubahannya..

sekarang klik salah satu tool keren di photoshop Healing brush tool.. ukuran brush 
secukupnya



25

cara pake nya ..

tekan ALT lalu klik di tempat yang gak ada kerutannya..

kalo udah tombol ALT nya lepas.. lalu klik di tempat yang berkerut-kerut

hilangkan semua kerutannya.. kalo bisa zoom..

hasilnya :
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sekarang lihat perbandingannya :

simple banget kan ? kalo tau caranya sih semua jadi simpel
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Training: Menambal Gigi Ompong

12. Mar, 2009 1 Comment

Teknik ini sama dengan teknik memperbaiki rambut yang (maaf) botak, atau kumis 
berantakan. Dengan hanya menggunakan Stamp tool, semuanya dapat diperbaiki dengan 
mudah.

Caranya: aktifkan Stamp tool, lalu pilih ukuran brush sesuai area yang akan ditutup, pilih tipe 
brush yang halus. Pada bagian Option bar, kurangi Opacitynya sesuai kebutuhan.

R

Training: Menghilangkan Noda

21. Mar, 2009 7 Comments

Teknik menghilangkan noda sangat mudah dan simpel. 
Dengan memanfaatkan Healing Brush tool, maka dalam sekejap segala noda, jerawat, 
keriput, maupun bercak lain akan hilang. Caranya: Aktifkan Healing Brush tool atau, 
kemudian pilih ukuran brush yang sesuai. Klik pada daerah yang akan dihilangkan.
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Training: Mewarnai Bibir

21. Mar, 2009 6 Comments

Teknik ini mungkin sudah sering digunakan dalam memperbaiki 
warna rambut, baju, dan warna lainnya. Nah berikut ini cara mewarnai bibir agak lebih 
natural. Cara? Perhatikan video tutorial di bawah ini.

Tools

07. May, 2007 22 Comments
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SPOT HEALING BRUSH (J): Tool ini dapat memindahkan noda/cacat 
secara cepat dan ketidaksempurnaan lain pada gambar. Spot Healing Brush tool bekerja 
dengan cara mengambil sampel dari gambar atau tekstur yang tepat, pencahayaan, dan 
pixel yang telah diperbaiki secara otomatis. Tidak sama dengan Healing Brush yang 
menutupi cacat dengan cara mengambil sampel yang kita tentukan, Spot Healing Brush 
secara otomatis mengambil sampel warna yang sesuai untuk menutupi daerah yang cacat.

Caranya: aktifkan Spot Healing Brush tool, kemudian aturlah ukuran brush dan tingkat 
ketajaman (hard). Selanjutnya, goreskan pada daerah yang kotor secara perlahan-lahan.

.
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HEALING BRUSH (J): Untuk memperbaiki bagian image yang cacat, kotor, maupun 
tergores dengan warna lain dengan cara menduplikasi dari warna atau pola pada bagian 
lain.

Caranya: tekan tombol Alt sambil mengklik tombol mouse pada daerah yang ingin dijadikan 
sumber. Lepaskan tombol Alt, lalu goreskan pada daerah yang ingin diperbaiki/dihilangkan.

PATCH (J): Untuk memperbaiki bagian image yang cacat, kotor, maupun tergores dengan 
warna lain dengan cara memilih sumber warna/pola pada bagian lain.

Caranya: aktifkan Patch tool, seleksi daerah yang ingin diperbaiki menggunakan tool 
tersebut. Setelah terbentuk seleksi, seret ke daerah lain sebagai sumber untuk menutupi 
daerah yang kotor.
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RED EYE (J): Seperti namanya, tool in dapat menghilangkan efek Red eye pada foto Anda.

Caranya: aktifkan Red Eye tool, kemudian klik pada mata yang berwarna merah (Red Eye). 
Jika kurang puas dengan hasil yang telah dibuat, Anda dapat membatalkannya kemudian 
atur menu option di bagian atas. Aturah ukuran Pupil (Pupil Size) dan tingkat gelap pupil 
(Darken Pupil).

CLONE STAMP (S) : Untuk menggambar dari sampel pada sebuah image.

Caranya: aktifkan Clone Stamp tool dan aturlah ukuran brush, pilih tipe yang lembut (Soft). 
Selanjutnya klik pada daerah yang akan dijadikan sampel sambil menekan tombol Alt. lalu 
klik pada daerah lain yang akan dijadikan target. Teknik ini biasanya digunakan untuk 
memanipulasi sebuah image ketika menambahkan objek yang sama.
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PATTERN STAMP (S): Untuk menggambar dari bagian atau pola yang telah diambil.

Caranya: aktifkan Pattern Stamp tool, pilih ukuran dan tipe brush. Selanjutnya, pada menu 
option di bagian atas, tentukan jenis pola (pattern) yang digunakan untuk menggambar.

ERASER (E) : Untuk menghapus objek dan dapat mengembalikan objek yang sudah 
terhapus ke posisi semula.

Caranya: aktifkan Eraser tool, pilih ukuran brush dan pilih tipe brush yang lembut (Soft), jika 
perlu perkecil tingkat kepekatan (opacity). Semakin kecil nilai opacity maka akan semakin 
lembut bagian tepi objek yang telah terhapus.

BACKGROUND ERASER (E) : Untuk menghapus latar belakang (background) agar menjadi 
trasparan.

Caranya: akifkan Background Eraser tool kemudian aturlah beberapa spesifikasi pada 
Option bar. Pada opsi Limits, pilih tipe Contiguous agar warna yang pertama kali terhapus 
menjadi acuan untuk menghapus warna berikutnya.

MAGIC ERASER (E) : Untuk menghapus warna yang solid dengan cara mengklik sekali 
pada bagian tertentu.
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Caranya: aktifkan Magic Eraser tool, kemutian aturlah nilai Tolerance (semakin besar 
nilainya maka warna yang berdekatan akan ikut terhapus), Anti-alias (jika diberi tanda 
centang maka warna yang terhapus semakin lembut), Contiguous (jika diaktifkan, akan 
menghapus bagian lain), dan Sample All Layer (jika diaktifkan, semua layer di bawahnya ikut 
terhapus).

BLUR: Untuk memperhalus bagian tepi sebuah image. Teknik ini juga sering digunakan 
untuk memperhalus bagian-bagian tertentu, misalnya memperhalus bagian wajah atau 
memper-halus pixel yang terlalu besar.

Caranya: aktifkan Blur tool, aturlah spesifikasi pada Option bar. Goreskan brush pada 
daerah yang ingin dibuat kabur (blur).

SHARPEN : Untuk mempertajam bagian tepi sebuah image.

Caranya: aktifkan Sharpen tool, aturlah spesifikasinya pada Option bar. Goreskan brush 
pada daerah yang ingin dibuat tajam.

SMUDGE: Untuk membuat efek sentuhan jari pada cat basah. Teknik ini sering digunakan 
untuk menggambar secara digital.

Caranya: aktifkan Smudge tool, tentukan ukuran dan tipe Brush (atur pula tingkat 
ketajaman). Aturlah Mode dan Strenght (radius efek goresan brush, semakin besar nilaninya 
maka akan bagian lain ikut terkena dampaknya) pada Option bar. Goreskan brush pada 
daerah yang diinginkan.

DODGE: Untuk memberikan warna terang pada daerah tertentu.

Caranya: aktifkan Dodge tool, aturlah ukuran dan tipe brush, aturlah pula pada Strenght 
(semakin besar nilainya maka akan semakin terang).

BURN : Untuk memberikan warna yang gelap pada daerah tertentu dengan goresan brush.

Caranya: sama seperti Dodge tool.

SPONGE: Untuk meningkatkan saturasi (saturation) pada objek.

Caranya: sama dengan Dodge tool.

PHOTOSHOP DODGE BURN SPONGE

Burn Tool menggelapkan luas foto; Perangkat Dodge mencerahkan area dari suatu gambar. 
(Alat ini didasarkan pada teknik pengembangan fotografi untuk eksposur pengendalian pada 
bidang spesifik mencetak.)
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Sponge Tool, ditemukan dalam menu flyout sama seperti Dodge Tool dan Burn Tool, 
perubahan tingkat kejenuhan warna untuk area dari suatu gambar.

Pada contoh berikut, kita menggunakan Burn Tool untuk menggelapkan dinding yang 
mengelilingi pintu, dan Sponge Tool untuk jenuh warna gazebo.

  

Gambar Asli  Adjusted Image
Bagaimana menggunakan Burn, Dodge DAN Sponge?
1) Pilih salah satu Burn, Dodge atau Sponge Tool dari Toolbox.

Pilihan Bar pilihan (terletak di bagian atas layar) akan berubah berdasarkan atas mana alat 
yang Anda pilih (Burn dan Dodge memiliki opsi yang sama):
Burn

Dodge

Sponge

2) Pada Bar Options, pilih ukuran kuas dan jenis sikat yang ingin Anda gunakan dari menu 
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pull-down Brush. (Klik panah di sudut kanan atas palet kuas untuk melihat menu untuk 
pilihan kuas tambahan.)

3) Juga pada Options Bar, mengatur persentase Paparan atau Tekanan untuk antara 10 dan 
15%. (Semakin rendah persentase, yang kurang drastis efeknya, memungkinkan Anda untuk 
mempertahankan kontrol yang lebih tepat jumlah keringanan, gelap, atau menjenuhkan.)

4) Jika Anda menggunakan Burn atau Dodge Tools, pilih Shadows, Midtones, atau Highlights 
dari menu Range pull-down di Options Bar.

ATAU

Jika Anda menggunakan Sponge Tool, pilih Saturate atau Desaturate dari menu pull-down 
Mode di Options Bar.

5) Menggambar dengan mouse untuk membuat efek.


